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INTRODUCTION 
 

This manual provides basic information on how to maintain 

the musical equipment inventory in a Fleet/area band, as it is 

impossible to write a manual that covers all possible scenarios. 

 Use this manual as a reference guide for assistance in the daily 

operations of supply. 
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CHARMS MUSIC 
 

     CHARMS MUSIC OFFICE ASSISTANT is an online database program 

that allows bands to view their inventory in a real-time 

environment.  Bandmasters, Assistant Directors, and Supply 

Assistants can log on to the CHARMS Music website at 

https://www.charmsoffice.com/ to view instruments and 

accessories, assign instruments and accessories to band members, 

and update condition codes. 

 

     Each band has a unique username and password provided by 

PERS-4014.  If the username or password information is lost, 

please contact the Materiel Manager for a password reset.   

 

     From the above website, click the “Green” plus sign located 

in the upper right box labeled “Teachers – Helpers, Click Here,” 

input username and password, then click the “Enter CHARMS” button 

to use the database.   

 

 

 

 

 

 

 The first screen after logging-in to CHARMS is “The Hub.”  

From this screen, band members can be added or transferred, and 

inventory items can be assigned or viewed.  It is recommended 

that new users take the tutorial listed under the Help tab; it 

will help develop familiarity with the program. 
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QUICK REFERENCE 
 

     Once on “The Hub” screen, click the tab marked “Inventory;” 

this will open the main inventory page from which most tasks are 

accomplished.  There are two types of items in the PERS-4014 

inventory:  equipment and accessories, differentiated as follows: 

  - an equipment item has a unique serial number and each 

is an individual line item in CHARMS with a quantity of one.  For 

instance, a trumpet is an example of equipment. 

  - accessory items are groups of similar things that are 

not individually serialized.  The quantity of accessories should 

reflect what are actually on board.  For example, a music stand 

is an accessory. 

 

There are numerous ways to display the inventory.  From the 

inventory page, a drop-down menu is available, which lists items 

by category (i.e. brass).  Select the category from the menu, and 

then click on the item to view details about that item.  In 

addition, by clicking on the “Reports” tab located at the right 

side, there are preset categorized listings of the ways to view 

inventory items.  The “Assign/Return” tab on the right side is 

used to assign an equipment item to a band member.  Click on the 

tab and a drop-down menu of all band members appears (See page 6 

for information about adding members); select the member by 

clicking the name.  A new drop-down menu appears with inventory 

categories.  Follow the drop-down choices until the item to be 

assigned is located, and then select the item to be assigned:  

the item is now assigned to the member.  To return an item to 

inventory, click the return button next to the item.  Note that 

CHARMS does not support assigning accessories to members.  Assign 

accessories to individual members in the Comment block of the 

accessory.  For example, if MUSN Smith needed a trumpet stand, 

the STAND- TRUMPET comment block may read:  On board-10; 1-MUSN 

Smith, 1-MU3 Jones, 8-stock. 

 

    The “Modify” tab is used to view details of an item and make 

appropriate changes.  After clicking on the “Modify” tab, 



 
 
6

navigate via the drop-down menus to the desired item.  This 

option is useful for Supply Assistants to keep equipment 

condition codes up-to-date, ensure accurate quantities of 

accessories, and add remarks in the “Comments” section.  The 

Materiel Manager or Materiel Supervisor will need to make all 

other changes to items.  

 

     The “Members” tab, located at the top, provides the ability 

to add or delete band members.  After selecting the “Members” 

tab, a drop-down menu appears listing all current members at the 

activity.  To add a new member, select the “New Member” tab 

located on the right.  For our purposes, only the blue fields are 

required, and to keep it uniform do not use all caps.  The 

“student ID” will be the member’s last name.  The first and last 

name fields are required to be filled in, all other fields are 

optional.  To delete a member from the roster, follow the same 

steps to view the member’s details.  Select “Delete Member” from 

the drop-down menu below the member’s name; a new screen appears 

showing any inventory items still assigned to the member.  Note: 

These items must be returned to inventory before a member can be 

deleted.  If the member does not have any items checked out, type 

in a reason for the deletion (such as member transferring or 

separating) and click delete.  If assistance is needed, please 

contact the Materiel Manager at PERS-4014. 
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ANNUAL INVENTORIES 
 

     The Navy requires an annual inventory of all instruments, 

accessories, and office equipment.  Commander, Navy Personnel 

Command (PERS-4014) will contact the activity to set an inventory 

date.  If unexpected operational commitments conflict with the 

established due date, inform PER-4014 by e-mail.  An accurate 

inventory is imperative.  The date can be changed as needed.  

Note:  Do not wait for the inventory to identify equipment in 

need of replacement or repairs; do this as soon as repairs are 

required.  If an item is critically needed, request a replacement 

immediately! 

 

REPORTS 
    To print a complete inventory, log-on to the CHARMS Music 

Website (see page 4).  From the “Inventory” screen, click 

“Reports”, under “Inventory Report List” click “Inventory report 

by Category”, from this point the inventory can be printed. 

It is recommended to block time in the weekly schedule to 

properly inspect equipment and accessories that have been issued, 

keeping in mind that "in-stock" items can be counted without 

conflict with the normal operational schedule.   

 

SERIALIZED EQUIPMENT 
  Each piece of serialized equipment must be visually inspected 

to verify the make, model, and serial number against the printed 

inventory report.  Do not rely on tags, stickers, etc. to verify 

serial numbers.  ALWAYS verify the actual serial number on the 

equipment, and notate current condition codes and discrepancies 

on the printed report.  BUPERSINST 4205.3 provides a complete 

description of condition codes.  Notate any equipment listed in 

"R" condition with a short description of the damage which will 

be used when inputting the information to CHARMS.  Additionally, 

justification must be provided for equipment that is in excess of 

the allowance list (NAVPERS 15875F).   
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ACCESSORIES 
  For the accessories section, update the quantities of each 

line item on the printed report.  As with serialized equipment, 

justification is required for excess items.  Description of 

damages to accessories is also required.  

 

CHARMS 
  After visually inspecting the inventory, update the condition 

codes and quantities on the CHARMS Music Website and make all 

required remarks in the “Comment” box.  Bands may use 

abbreviations such as: 

 

ER (excess required) with a short description as “extra 

instrumentalist assigned,” “required for Concert Band 

use” or reasoning as appropriate;  

ENR (excess not required) for any instrument or accessory 

that is no longer needed.  This is an excellent way to 

remove excess items from the bands inventory.  Keep in 

mind that you should not necessarily wait for inventory 

to do this. 

NRR (no replacement required) if an item is out-of-date or 

no longer needed to complete the mission. 

 

Excess equipment, which is not justified, will be subject to 

disposition instructions.  

 

    Notify Commander, Navy Personnel Command (PERS-4014) when the 

inventory has been completed via the Bandmaster/Director, and 

PERS-4014 will send a letter with disposition instructions.  If 

replacements items are “Out of Stock”, they will be provided when 

available without further correspondence from the band. 
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CUSTODY CARDS 
 
 
    Each piece of serialized equipment will have a custody card 

(NAVSUP FORM 306) as directed in BUPERSINT 4205.3.  Additionally, 

each accessory must have a custody card.  Custody cards are the 

legal documents that prove a piece of equipment is checked out to 

an individual:  the individual assumes legal responsibility for 

the equipment listed on the custody card.  The member checking-

out the equipment must sign and date the card, and the Supply 

Assistant will initial after the signature.  If the item is being 

returned to stock, the Supply Assistant will sign for the 

equipment with the word "STOCK" written on the card. 

 

    Custody of equipment will never go directly from one 

individual to another without going through supply first.  The 

following is an example of how this should work: 

 

Petty Officer Jones wants a snare drum that Petty 

Officer Smith has checked out.  Petty Officer Jones 

must first check the snare drum into supply.  The 

Supply Assistant will return the snare drum to stock, 

and then sign it out to Petty Officer Smith because 

this lets the Supply Assistant see the piece of 

equipment and checks its condition. 

 

When directed to send a piece of equipment to Navy Band 

Fleet Support Unit (NBFSU) for repair and return, make an entry 

on the custody card stating when the item was repaired and what 

was done to it.  Include the DD Form 1149 shipping document 

numbers in this entry.  For example, “Sent to NBFSU for repair on 

1149#XXXXXX.  Returned by NBFSU on 1149#XXXXXXX.”  Items that are 

for disposal, lateral transfer, or excess not required should be 

removed from the active files.  Notate on the card where the 

equipment went, the date it was removed from the inventory, the 

disposal document number or shipping document number, and the 

serial number of the directing letter.  Place these used cards in 
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the "DEAD" card file.  Sort these cards by instrument type and 

then by removal date, filed by fiscal year, and retain these 

cards for seven years. 
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EQUIPMENT TURN-IN 
 

Equipment returned to supply will be cleaned and be turned 

in with all accessories or parts that belong with the equipment. 

 The member is responsible for all accessories for each piece of 

equipment.  Accessory items such as reeds, mouthpieces, strings, 

neck straps, and instrument stands will be removed from the case 

for turn-in.  

 

An “Accessories” field was added into CHARMS in March 2009: 

all high-value accessories for each equipment item should be 

listed in this field.  If this accessory field is inaccurate, 

consult the Materiel Manager for guidance on updating. 

 

A Section Leader should inspect all instruments before it is 

returned to Supply.  Section Leaders should verify that the 

equipment is clean and in working condition.  PERS-4014 

recommends using a routing slip to verify that the equipment has 

been inspected.  The individual returning the equipment will take 

this slip to the Supply Assistant for turn-in.  The Supply 

Assistant should ask the individual if the equipment requires 

repairs.  If the equipment is in “R” condition, fill out the NMP 

Form 4400-1 and place it inside the case:  this form is required 

when sending equipment to NBFSU or sent out for local repairs.  

Contact the Materiel Manager for permission to use a local repair 

facility if damaged equipment is mission-critical or an urgent 

requirement.  Repairs must take place as soon as possible; once 

again, do not let equipment sit on the shelf in a repair code.   

    Tag the equipment with make, model, serial number, and 

present condition.  Make the necessary entries on the instrument 

tag, CHARMS and personal custody card, then properly store the 

instrument.   
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EQUIPMENT FOR DISPOSAL 
 

    All equipment directed for disposition by PERS-4014 must be 

disposed of per instruction within six weeks.  If more time is 

needed, contact PERS-4014. 

 

     The Bandmaster/Director may request to keep items marked for 

disposal that are still needed or desired.  If approved, the 

equipment will remain on the inventory:  the equipment will still 

count against the bands allowance for that particular piece of 

equipment.  Equipment turned over to disposal does not have to be 

in working condition.  It is acceptable to turn in cannibalized 

equipment, but the proper condition code on the disposal document 

that corresponds to the condition of the equipment must be used. 

 

 Check with the local property disposal office for guidance. 

 Software will be disposed of “in house,” which means to destroy 

the software by cutting it up or by some other means that renders 

the data unrecoverable, and throw it in the trash.  It is not 

necessary to take software to DRMO for disposal.  Request for 

disposition of equipment may happen at any time; an example 

letter is listed in Appendix A.  No equipment or accessory listed 

on the inventory may be disposed of without prior written 

approval from PERS-4014.  Only the Bandmaster/Director/Commanding 

Officer, Assistant Director, or Senior Enlisted Leader has the 

authority to sign disposal documents.   

 

 When turning equipment over to the local DRMO/DPDO, do not 

leave without a signed and dated copy of the DD Form 1348-1A as 

proof of receipt.  Notate the DD Form 1348-1A document number in 

the comments section in CHARMS of each disposed equipment item, 

and as mentioned before, on the custody card to be placed in the 

Dead File.  

 

Reutilization/Transfer/Donate (R/T/D) Program is a DRMO 

program that enables local school systems to acquire unclaimed 

disposal equipment.  DRMO uses this program for all types of 
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equipment, not just musical instruments.  To utilize this 

program, go to http://www.drms.dla.mil (DRMS website). 
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PREPARING DISPOSAL DOCUMENTS 
(DD FORM 1348-1A) 

 

    DRMO is the program the military uses to dispose of R-4 

equipment.  Go to https://www.drms.dla.mil/index.shtml for all 

the information required to fill out a DD Form 1348-1A.  Check 

with the local disposal office and past documents for additional 

guidance. 

 

    DOUBLE CHECK the disposal document before the equipment goes 

to disposal.  Check the quantity, make and model names, and 

serial numbers listed on the document, and reconcile against our 

letter for each piece of equipment being sent to disposal. 
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FILES 
 

    It is important to keep complete, accurate, and up-to-date 

files.  Four files are required to do the job, and these should 

be kept by calendar year: 

 

    1.  Original disposal documents (DD Form 1348-1A). 

 

    2.  Original outgoing shipping documents (DD Form 1149). 

 

    3.  Original incoming shipping documents (DD Form 1149). 

 

    4.  Master file which contains all actions relating to a 

specific letter.  This file will contain the band’s letter, e-

mails, PERS-4014’s response, a copy of any incoming shipping 

documents, a copy of any outgoing shipping documents, and a copy 

of any disposal documents.  Organize this file by letter date. 
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MISSING EQUIPMENT 
 

    Missing, Lost, or Stolen equipment must be reported as 

directed in NAVPERSCOMINST 4205.3.  Once the DD Form 200 is 

completed at the activity level, PERS-4014 will complete blocks 

14 and 17 and return the form.  "Expend from Inventory" will be 

typed in block 14b; this action deletes the item from activity’s 

inventory.   

 

REMEMBER:  A replacement instrument must be requested.  
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SHIPMENTS TO FLEET SUPPORT 
 

    When directed to send equipment back to NBFSU, use the 

following checklist: 

 

    1.  Check all the equipment that is being sent back and all 

the accessories/parts are for the right instrument.  A plastic 

clarinet barrel with a wood clarinet, a clarinet without a barrel 

or an amplifier or synthesizer without the pedals should not 

occur.  Instruction manuals must also accompany all electronic 

gear, as NBFSU does not have copies for issue. 

 

    2.  Make sure that the items going back to NBFSU are the 

items listed in the letter.  Check the make, model, and serial 

number of each piece of equipment against the letter. 

 

    3.  Ensure that the instruments being shipped are clean. 

 

    4.  Enclose NMP Form 4400-1 with a detailed description 

stating what is wrong with the piece of equipment.   

 

    5.  Check the shipping document against the items that are 

being sent.  Make sure they match the shipping document in 

description, make, model, serial number, and quantities. 

 

REMEMBER:  When turning over equipment to shipping, get signed 

and dated copies of the DD Form 1149 as a record of receipt.  Fax 

an advance copy of the 1149 shipping document to NBFSU and put a 

copy of the 1149 in the shipment. 
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PREPARING SHIPPING DOCUMENTS 
(DD FORM 1149) 

 

    Whether the activity or the base shipping department prepares 

DD Form 1149, the information listed below must be on this 

document.  Check with the local shipping department for any 

additional information. 

 

Block 3:   Director, Navy Band Fleet Support (UIC: N35392) 

           1349 11th Street 

           Naval Amphibious Base, Little Creek 

           Norfolk, VA  23521-5240 

           TEL: (757) 462-7307 POC: PAT MALLETTE 

 

Block 4:  TAC-N3GC. This number changes occasionally.  Pers-4014 

will notify the bands when the number changes. 

 

Block 4b:  Type the complete description as it appears on the 

inventory, including make, model, and serial number for 

instruments.  If the item is being returned for "Repair and 

Return" or “Lateral Transfer”, notate that next to that line 

item. 

 

Block 4c:  The unit of issue is an abbreviation of the types of 

units under material is issued.  EA – Each, PR – Pair, SE – Set, 

BX – Box, PG – Package. 

 

Block 4d:  This number should match the number of items actually 

being shipped. 

 

Block 6:   To construct this number, use the... 

• five-digit activity UIC (N _ _ _ _ _); 

• four-digit Julian Date; 

• band letter code (See list on next page) 

• next three-digit shipping document number in sequence (0001, 

0002, 0003...). 
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Band Letter Codes 

NBFSU - "A" 

FFB - "B" 

CNE - "P" 

GLKS - "D" 

NOLA - "F" 

NBNE - "G" 

PACFLT - "H" 

C7F - "R" 

NBSE - "Z" 

NBSW - "C" 

NBMS - "M" 

            

REMEMBER - start with 0001 at the beginning of a new fiscal year. 

 

           EXAMPLE: BAND UIC: N12345 

           SHIPPING DATE: 16 March 2005 

           NEXT DOCUMENT NUMBER: 0010 

           SHIPPING DOCUMENT NUMBER: N1234590750010 

 

Block 8:   Priority Designator.  There are three priority 

designators that should be used for shipments.  The highest 

priority is 8, used for FEDEX next-day delivery.  Priority 10 

should be used for performance-impaired shipments.  The lowest 

priority is 15, used for routine shipments.  Enter a reasonable 

required delivery date in block 7. 

 

Block 9:   Type the serial number and date from PERS-4014 

directing shipment of these items. 

 

Block 10:  Contains the Bandmaster/Director signature block.   

 

DOUBLE CHECK shipping documents before the items go to shipping. 

 Check the quantities, make, and model names and serial numbers 

listed on the document against each piece of equipment being 

shipped and against our letter. 
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LATERAL TRANSFERS 
 

   If a member finds an instrument that works well and wishes to 

retain that instrument, the instrument can be transferred to the 

next activity at which the member will be stationed. 

 

1.  The member requests in writing that the instrument (make, 

model, and serial number) be transferred to the next activity.  

See APPENDIX A for an example of the memorandum.   

 

2.  With Director or Bandmaster endorsement, the Supply Assistant 

will forward the request to PERS-4014. 

 

3.  Once PERS-4014 approves the transfer, a letter will be sent 

to the member via the Band. 

 

    When the authorization letter arrives, the Supply Assistant 

fills out a DD Form 1149 and sends the instrument to Fleet 

Support Unit for inspection and repair if necessary.  Once 

completed, Fleet Support Unit ships the instrument to the 

member’s next duty station. 
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RECEIPT OF EQUIPMENT 
 

Once a shipment arrives from NBFSU, several important items 

require attention.  Equipment cannot be checked out until all 

these steps are completed. 

 

Check the condition of the shipping cartons when the 

equipment first arrives from shipping.  If the carton is damaged, 

there is a good chance that the contents will also be damaged.  

If the carton and the equipment inside are damaged, a claim 

against the shipping company must be initiated immediately 

because, in most cases, a claim must be submitted within fifteen 

days.  Check with the local shipping department for more 

information on how to initiate a claim. 

 

Next, check the make, model, serial number, and quantities 

of the equipment against the shipping document attached to the 

carton.  If there is no shipping document, use enclosure (1) of 

our letter.  Verify all equipment and related accessories are 

present, appear in satisfactory condition, then sign and date the 

shipping document as proof of delivery from shipping.  It might 

not be possible to check serial numbers of the equipment upon 

delivery, but quantities and overall condition of the equipment 

must be checked before receiving the equipment from the shippers. 

 Take the equipment back to supply and type the necessary custody 

cards for all serialized equipment, and have someone try the 

equipment to make sure it works.  NBFSU regulates and checks all 

instruments before they are shipped, however, it is possible that 

equipment might get out of alignment or have internal damage due 

to shipping:  NBFSU cannot control the effects of shipping on 

equipment, especially to OCONUS locations. If there is a problem 

with a piece of equipment, call NBFSU. 

 

Once all steps are completed, fax a signed and dated copy of 

the DD Form 1149 to NBFSU and PERS-4014.  Once NBFSU and PERS-

4014 have received a copy of the 1149, the items listed will be 

added to CHARMS. 
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CARE OF EQUIPMENT 
 

    Cleaning is the most procedure to prolong equipment life.  

Routine cleaning of acoustic and electronic instruments is 

required.  Preventive maintenance is also required on most 

equipment, and may be as simple as tightening screws (excluding 

woodwind adjustment screws), oiling valves, or replacing lugs.  

It is not necessary to be an expert repairperson to do obvious 

preventive maintenance.  CAUTION:  If in doubt about a repair - 

do not do it! 
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SECURITY 
 

    All unissued instruments should be stored in a locked, 

climate-controlled area.  Access should be limited for security 

control.  Equipment issued to individuals should be secured in 

the cases provided with the instrument when not in use and 

secured in instrument storage lockers. 

 

    Large items that do not fit in a storage locker should be 

stored in secure rooms and out of the way.  Individuals are 

responsible for instruments assigned to their custody.  

Government equipment should never be left unsecured/unattended.  

Equipment should never be left in a Personally Owned Vehicles 

(POV). 
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PRIVATELY-OWNED EQUIPMENT 
 

     Although use of personal items is authorized, members do so 

AT THEIR OWN RISK.  The Navy cannot accept responsibility for 

damage or theft of personally-owned items used in the performance 

of duty, except in cases where specific authorization has been 

obtained due to the Navy's inability to provide a "required" item 

essential to the mission (PERS-4014 is the sole authorizing 

agent).  All Navy Bands maintain an inventory of professional 

quality equipment for use.  Members are strongly encouraged to 

obtain personal insurance coverage if they choose to use 

privately-owned items. 
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STORAGE OF EQUIPMENT 
 

    All equipment in storage must be clean and clearly labeled.  

Place a tag on the outside of the case with the make, model, 

serial number, and condition of the instrument when the 

instrument is received or returned to stock.  The tag will help 

identify instruments in storage and their condition.  Notate any 

discrepancy with the instrument on this tag, such as missing 

lugs, rims, pedals.  If there are empty cases on the shelves, 

label them as empty.  REMINDER:  These tags help in the daily 

operations of supply.  Open all cases and double-check make, 

model, and serial numbers while doing the annual inventory. 

 

Don’t store accessory items such as reeds, mouthpieces, 

strings, neck straps, stands, or other items in instrument cases. 

 These items should be removed during turn-in and stored 

separately, however store any keyboard foot or volume pedals with 

the instrument.  Maintain a file of all manuals for electronic 

equipment; if feasible, retain the original manual in Supply and 

make a copy for issue. 

 

Notate on the tag if an instrument has been identified for 

disposal or for shipment back to Fleet Support.  Store these 

items separately from other items in supply if space allows.  

This will prevent issue of this supply. 

 

If instruments returned to supply require repairs and these 

repairs cannot be accomplished locally, fill out NMP Form 4400-1 

and place it with the equipment.  Notate this clearly on the tag 

to avoid re-issue before repairs have been completed.  A letter 

must be written to PERS-4014 requesting replacement.  Again, 

repairs should be completed as soon as reported, do not wait for 

inventory time. 
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APPENDIX A 
 Today’s date 
 
From:  MU3 I. M. Whoever, USN 
To:    Commander, Navy Personnel Command (PERS-4014) 
Via:   Director, Navy Band Present Command 
 
Subj:  LATERAL TRANSFER OF MUSICAL INSTRUMENTS 
 
Ref:   (a) PHONCON NBPC (MU2 Supply Assistant)/PERS-4014 (MU1 Peters) of (date 

   of PHONCON) 

1.  As discussed in reference (a), I respectfully request to laterally 
transfer the following equipment to Navy Band Next Command to be issued for my 
continued use: 
 
 Instrument(s), Make, Model, Serial Number 
 
2.  My transfer date is (list transfer date). 
 
 
 
 I. M. WHOEVER 
 
…………………………………………………………………………………………………………………………………………………………………………………………………………… 
 4002 
 Ser NBPC/xxx 
 Today’s date 
 
FIRST ENDORSEMENT 
 
From:  Director, Navy Band Present Command 
To:  Commander, Navy Personnel Command (PERS-4014) 
 
1.  Forwarded with my concurrence.  Replacement/no replacement instrument 
required. 
 
2.  My POC for this matter is MU2 Supply Assistant at DSN xxx-xxxx. 
 
 
 
 T. G. BANDMASTER 
 
 
Copy to:  MU3 Whoever 
 
***INSTRUCTIONS:  Member completes the top part of this letter 
and forwards to the Supply Assistant.  The Supply Assistant 
completes the bottom part for the Bandmaster’s endorsement and 
than forwarded to PERS-4014 NLT 60 days prior to the member’s 
transfer, so arrangements can be made for replacement 
instruments, if required.  Upon receipt of approval from PERS-
4014, the Supply Assistant will complete the necessary shipping 
documents to ship the instrument via military shipping to NBFSU 
inspection, repair if necessary and cleaning.  Upon completion of 
the required maintenance, NBFSU will ship the equipment to the 
member’s next duty station. 


